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MAXIMIZING THE EFFECTIVENESS OF INTERNET-BASED TESTING IN A 
STAFFING SERVICE ENVIRONMENT 
 
 
Introduction 
 
The Internet offers staffing services the ability to give “testing virtually anywhere.”  So 
what does this mean for staffing organizations that have invested thousands, if not 
millions of dollars to date in testing capability based in their own offices?  How does 
“testing virtually anywhere” affect test security and validity?  And how can the Internet 
impact the efficiency of applicant screening and placement now and in the future?   
 
This document provides a background on current capabilities of Internet-based testing 
systems, and discusses strategies for maximizing the effectiveness of this powerful new 
technology in ways the build on (rather than just replacing) a staffing company’s existing 
testing investments.   
 
 
Background 
 
Staffing services have been providing testing to job candidates for several decades.  Since 
the mid-1980s, testing on important software skills has utilized performance-based 
assessments (primarily interactive simulations).  This testing has been used primarily for 
job screening, as well as for marketing purposes, assuring customers of a candidate’s 
proficiency in key employment skills. 
 
In the beginning of the era of computer-based testing, most staffing services made use of 
the same testing products and the same tests.  Given these conditions, the marketing 
message behind testing primarily focused on proving that job candidates were meeting an 
unofficial industry standard in word processing and other software skills.   
 
In recent years, however, staffing companies have been using new testing capabilities to 
differentiate themselves from one another.  Innovations in testing have included: 
 

• Organizations creating their own standard tests, moving away from “one-size-fits-
all” third-party testing solutions. 

• Skills testing expanding into new areas, such as IT and Call Center skills, with 
assessments that include multimedia and other advanced testing features.   

• The introduction of personality profiling and other types of testing that assess 
attitudes and aptitudes, as well as skills. 

• Utilization of new technical testing advances, including adaptive testing, and 
testing over the Internet.   

 
The Internet opens up the opportunity to give testing anywhere in the world.  Via 
browsers, testing can run on desktop computers within a staffing company’s offices, at 
remote locations such as off-site locations and job-fairs, and even in the homes of job 
candidates.   
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However, in order to take advantage of the opportunities provided by “testing virtually 
anywhere,” staffing companies need to take an integrated approach to testing, 
determining where this new technology is best applied to provide the greatest benefit in 
terms of efficiency and economy.   
 
A well-designed testing system that includes an Internet component and integrates testing 
into the way a staffing company does business can also provide enormous marketing 
advantage to the service that does the Internet “right.”  Proper planning can also provide 
effective upgrade paths, eliminating the need to re-create an entire testing system with 
each advanced in Internet technology. 
 
 
Definitions 
 
Performance-Based Testing – Testing that requires an examinee to perform a specific 
task utilizing the actual system being tested, or a working simulation of that tool.  
Performance-based tests that utilize interactive simulations (such as SkillCheck and 
Qwiz) are examples of performance-based products that have become standards in the 
staffing industry. 
 
Linear Testing – Testing that utilizes traditional test item types such as multiple-choice, 
true/false, fill-in-the-blank and matching questions.   
 
Test Objective – The general or specific purpose of the test.  No proper test is developed 
by simply sitting down and writing questions.  Instead, an objective for the test is defined.  
This objective can be the screening of an examinee for a specific job (bookkeeper, 
secretary, etc.) or job segment (math, use of Excel, etc.).  Other test objectives can 
include pre-training assessment to determine what a candidate needs to learn, or 
certification for a specific license or credential.  Once this objective is defined, experts 
determine the knowledge, skills and abilities (KSAs) needed to meet this objective.  Only 
when those KSAs have been defined are the best questions utilizing the best question 
types (performance-based or linear) developed to match these KSAs. 
 
More information on performance-based vs. linear testing appears in appendix A of this 
document.  A detailed discussion of different types of testing methodologies can be found 
in the Resources section of SkillCheck’s Web page at http://www.skillcheck.com/. 
 
 
Performance-Based Testing vs. Linear Testing – Technical Issues 
 
Appendix A outlines issues of when performance-based or linear test content is best used 
to test specific knowledge, skills and abilities (KSAs).  Below is a discussion of purely 
technical issues regarding test deployment of each type of test item on standalone 
systems, networks and the Internet. 
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Current testing systems such as SkillCheck have the capability of running either 
performance-based tests or linear tests on standalone systems, LANs, Intranets, WANs 
and, recently, the Internet.  Performance-based tests are obviously more graphically 
intensive than linear tests requiring more hard disk space to store large numbers of 
graphics and sufficient throughput (on networks) for transmitting images from the server 
to the client. 
 
Issues of throughput become critical on the Internet since tests can be run on systems 
ranging from 28K dial-up modem connections to high-bandwidth dedicated DSL or T1 
lines.  Because of this, most Internet-based testing today is linear, consisting of multiple-
choice questions, some of which may include small graphics or simple multimedia 
elements supported on the Web.   
 
Deployment of linear test items over the Internet consists of placing standard Internet 
components (most commonly text and graphics) on the screen and receiving feedback via 
radio buttons or other standard Internet elements that write back to a database.  
SkillCheck, as well as other assessment vendors, have commercial products and services 
for developing and deploying linear tests over the Internet. 
 
Deploying performance-based tests over the Internet is more complex since each question 
can require the transmission of several hundred KB of information (notably graphics).  
This can result in slow performance, lessening the “illusion” of a simulation.  Solutions to 
this problem to date include: 
 

• The thin-client approach of the SkillCheck.COM product which runs testing 
completely from the server 

• The so-called “fat download” approach, a strategy in which a complete 
application is downloaded from the Internet server to the desktop where the 
downloaded test is run locally, normally communicating scores back to the server 
via an Internet connection.   

 
Both of these approaches involve downloading some component to the client, either a 
small plug-in (normally a few hundred KB) for thin-client or a large compressed file (as 
much as 3-10 MB) for the “fat download” option. 
 
Current technology, therefore, offers staffing services three options for delivery of testing 
over the Internet: 
 

• Delivery of linear (multiple choice) test content. 
• Delivery of performance-based test content via thin client. 
• Delivery of performance-based content via “fat download.” 

 



 4 

Advantages of Internet Testing 
 
As indicated above, Internet testing is an option today for staffing organizations.  Used 
effectively, Internet-based testing provides the following critical advantages: 
 
Centralization 
of test content 

Anyone who has had to oversee deployment of a software-based 
testing system understands the time and cost involved with providing 
disks or CDs to dozens, if not hundreds of locations.  Given the 
nature of skills-testing systems that are frequently updated to add new 
tests, new features or bug fixes, management of a software-based 
testing system becomes a significant and costly project within even 
staffing operations of modest scale.  The scale of typical deployments 
also makes it difficult to assure that testing is consistent across an 
entire operation. 
 
Internet test deployment solves this problem by maintaining a single 
source of test content that can be managed and updated from a central 
location.  Once updated, each office connected to such a system will 
immediately have access to the latest testing content without the need 
to perform any software installations or updates. 
  

Centralization 
of scoring 
information 

Just as the Internet can help centralize test content, the Net can also 
be used to centralize test scoring information.  While test scores have 
largely been used locally to make hiring decisions, a sharing of test 
scores between offices can help a staffing organizations create a more 
“portable” profile for job candidates as they move from one location 
to another.  Absent such centralization, candidates need to be retested 
if they decide to apply at more than one location of a staffing 
organization. 
 
Test scores also represent valuable data with regard to statistical 
analysis that can be performed to determine norms and other 
important information with regard to candidate and test performance.  
Only by centralizing scores can an organization have fast and easy 
access to all test scores needed to take advantage of this valuable 
data.   
 

Testing 
virtually 
anywhere 

Must testing take place only in a staffing company’s office?  Of 
course not!  This is where testing has traditionally taken place, and to 
be sure, the office does offer a degree of test security by providing 
testing within some kind of proctored environment. 
 
However, in-office testing has often been the only choice for a 
staffing company that could not afford the effort or cost of creating 
temporary testing stations at remote locations such as kiosks or job 
fairs.  And testing at home is not a possibility with current software 
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testing solutions. 
 
The Internet changes the old rules, providing access to a complete 
testing system on any computer that has a connection to the Internet.  
An Internet testing solution can be used to bring testing into the 
office, but it can also be used to set up instant test centers in remote 
locations, and even provide for testing of job candidates at home 
BEFORE they visit a staffing company’s office.   
 

Time 
advantages 

In a typical staffing office, processing a job candidate normally 
includes: 
 
• Filling out a job application: 15-20 minutes 
• Testing: 60-90 minutes (assuming standard testing on typing, 

Word, Excel and possibly one other application) 
• Interviewing: 15-20 minutes 
 
Even under optimum conditions, processing a job candidate can take 
well over an hour.  Overt costs of these long processes include: 
 
• Hardware and software needed to test multiple candidates at the 

same time 
• Lost candidates (many of whom may visit during a lunch hour 

from another job) who cannot afford the time needed for the 
complete in-office application/testing/interviewing process.  

• Staff time to manage processes (such as application processing 
and testing) that could have been completed BEFORE the 
candidate arrived for an interview through an application of 
Internet technology. 

 
As noted in the discussion of strategy below, considerations of timing 
are compounded by the fact that most of the time candidates spent 
being tested is wasted, with job applications spending a majority of 
time answering questions that are above or below their skill level. 
 
By locating testing (and possibly other processes like filling out job 
applications) outside the office, staffing companies have the 
possibility of reducing applicant time dramatically, increasing the 
number of candidates who can be processed without requiring 
additional staff.   
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Disadvantages of Internet Testing 
 
Cost Current testing software solutions have two major costs, the testing 

software itself (SkillCheck, Qwiz, etc.) and the hardware on which 
the software runs.  Hidden costs for software-based testing include 
the deployment costs described above, system training and support. 
 
An Internet-based testing solution will still require desktop PCs on 
which testing will take place and an Internet-based testing software 
product.  In general, Internet applications should be run on fast, 
modern computers, rather than legacy PCs.  And Internet testing 
software requires an investment at least as great as the cost of current 
desktop testing software solutions. 
 
An Internet-based testing solution also requires two components not 
needed for software-based testing: server hardware and software and 
connectivity.  While modem dial-up can be an option for at-home or 
remote testing, any Internet-based office testing solution should 
utilize a fast connection (DSL or T1) for effective test deployment. 
 
As noted above, a centralized testing solution can save an 
organization significant costs in product updates and deployment, as 
providing other valuable benefits (centralized scoring, at-home 
testing options, etc.).  That said, the per-workstation cost for 
deploying an Internet-based testing solution is likely to be the same 
or greater than current software testing options.   
 

Security Particularly with regard to testing at home, how do you know the 
person taking the test outside of your office is not cheating?  This is 
the greatest dilemma facing not just staffing services, but any 
organization interesting in remote testing. 
 
The strategies portion of this document outlines ways to minimize the 
risks of cheating, but it needs to be recognized that any testing 
solution that removes testing from a secure environment like a 
staffing service’s own office opens opportunities for problems 
inherent in unsupervised testing situations. 
 

Reliability The Internet is currently somewhere between its infancy and 
adolescence.  While it provides remarkable capabilities, it is prone to 
slow-downs and errors that are beyond the control of even the most 
sophisticated users. 
 
Current software-based testing solutions have proven to be generally 
reliable, if only because they tend to run on dedicated testing PCs that 
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do not rely on unpredictable resources like connections to the 
Internet.   
 
While Internet users who run applications infrequently (like home-
based users of a staffing service’s Web-based testing product) would 
normally expect slow-downs or other Internet “hiccups,” utilizing the 
Internet as the backbone to a staffing services’ enterprise-wide, 
office-based testing solution introduces new factors of reliability into 
a testing program. 
 

 
 
Strategy 
 
Given the advantages, disadvantages and technical realities of Internet-based testing 
described above, staffing companies have a number of strategies they can pursue: 
 
Internet Testing 
as a Primary 
Testing 
Platform 

One option is to replace existing software-based testing systems with 
a complete Internet solution, both in the office, and for distance-
testing at home, at job fairs or in other remote locations. 
 
Using the Internet as an in-office, primary testing system involves all 
of the benefits (centralized content and scores) and costs (client and 
server hardware and software and connectivity) described above.  For 
a broad deployment of this type, an organization either needs to 
invest in the resources needed to manage a high-bandwidth Internet 
product throughout an enterprise, or compromise test content by 
replacing performance-based tests with linear tests that can more 
easily be delivered over the World Wide Web. 
 
Apart from centralized in-office testing, an Internet-based testing 
solution also provides for remote testing, including testing at home.  
However, an organization will need to deal with the security issues of 
making the same tests available both in the office and remotely.  If 
remote access to the same testing content used in the office 
compromises an in-office testing program’s integrity, the best 
solution is to deploy different tests remotely than the ones that are 
made available in the office.  Options in this area are described 
below.   
 

Using the 
Internet to 
streamline an 
in-house testing 
solution 

While testing is often the most time-consuming part of the applicant 
screening process, other aspects of that process, such as filling out a 
job application, can be accomplished online without the significant 
bandwidth issues involved with Internet testing solutions. 
 
Having applicants fill out job applications and questionnaires before 
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they visit the office can help steamline the applicant process by: 
 
• Removing the 10-15 minutes needed to fill out a paper form in the 

office. 
• Eliminating the time and cost of entering that same information 

into a computerized search and placement system. 
• Helping an employment consultant plan a specific testing regime 

based on information provided by the applicant before they show 
up in the office. 

 
While testing will still take place in the office, having information on 
a candidate before they arrive can ensure that this testing process is as 
targeted and streamlined as possible. 
 

Remote Testing 
Options 

Given the current state of Internet testing, a reasonable middle ground 
is to utilize the Internet for remote testing (particularly at-home 
testing) while still making use of a software-based in-house testing 
solution.  The advantages of this approach include: 
 
• Letting high-volume, in-house testing continue to be performed 

on local PCs, freeing an organization from having to provide the 
hardware and bandwidth to support a centralized, high-volume 
testing solution. 

• Letting the Internet provide what the software testing solutions 
cannot: testing virtually anywhere. 

 
Such a hybrid solution can also help an organization get over some of 
the security issues that accompany Internet-based testing solutions.  If 
an Internet-based, at-home test is different than one given in the 
office, an at-home test-taker can be informed that they will likely be 
retested on at least one skill or application when they arrive at the 
office and that a discrepancy between test scores will put their 
employment at risk.  This security measure, even if only implemented 
occasionally, can help deter cheating on tests taken at home.   
 
The major benefit of this strategy is the saving of significant amounts 
of in-office time.  Even if all job candidates are re-tested on one 
application when they arrive in the office, this can still cut down in-
office testing time by as much as 70-80% 
 
To maximize the effectiveness of at-home testing, SkillCheck 
strongly recommends an integrated approach to at-home and in-office 
testing whereby one testing solution builds on the other.  Examples of 
this strategy appear below. 
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To recognize the benefits of Internet-based testing, one needs to change one’s thinking 
from looking at home-based testing as a complete replacement to testing you do at your 
offices, to thinking about home testing and office-based testing as components that build 
on one another. 
 
As already noted, by indicating to job candidates before a home-delivered, Internet-based 
test is given that they will be re-tested on at least one application when they get into the 
office and that any discrepancy in their scores can affect their placement opportunities, 
your office-based tests become an immediate deterrent to cheating.  
 
However, home-based and office-based testing can also build to a whole much greater 
than the sum of their parts.  Some examples of hybrid testing solutions that allow a 
service to gain maximum benefit of their testing systems are described below. 
 
Example 1 – Using Testing at Home to Determine Skill Level 
 
A well-designed, home-based test can be used for a different objective than an office-
based test.  In the current software test model used by literally every staffing company, 
tests are given in the office to assess specific skills for job placement and (less 
frequently) training analysis.  Thus, the objective of current in-office testing is to 
determine specific areas of knowledge and skills in order to make job placements. 
 
Home-based tests can be used not to determine exactly the same things as an in-office 
test, but to analyze a job candidate’s skill level on one or multiple skills in order to more 
efficiently test and interview candidates when they arrive at the office. 
 
The benefits of this approach are best illustrated by the following examples:   
 
Of two job candidates visiting a staffing company for job placement, Candidate A has a 
high level of skill in several Microsoft Office applications, while Candidate B only has 
experience in simple word processing.  While interviewing and application procedures 
are sometimes used to pre-screen candidates before testing, the tendency for candidates to 
inflate their resumes often leaves consultants in the position that they simply give the 
same set of tests to each candidate.   
 
As already described, in a typical office, then, the process for each candidate is similar: 
 
• Filling out application – 15-20 minutes 
• Testing – 60-90 minutes (assuming standard testing on typing, Word, Excel and 

possibly one other application) 
• Interview – 15-20 minutes 
 
Given this model, each candidate can spend as much as two hours in your office.  As 
already noted, since many candidates visit a staffing company on their lunch break or 
after hours, the long processing time can mean a loss of possible applicants (significantly 
lowering recruitment levels) or extended evening or morning hours. 
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The worst part of this situation is that most of this in-office time is unnecessary.  The 
application procedure could be done online from home, shaving 15-20 minutes from the 
process.  And most of the testing time spent by both candidates described above has been 
wasted.  Candidate A (the highly-skilled candidate) has spent most of his or her testing 
time answering questions below his or her skill level, and Candidate B has been 
struggling to answer a large number of questions that are beyond his or her ability. 
 
Had a suitable set of tests been given from home to each candidate before he or she 
arrived, their levels of skill could have been ascertained and appropriate testing applied to 
determine specific areas of knowledge. 
 
For example, an Internet-based test for Candidate A would have determined that he or 
she was an advanced user of Word and Excel.  Because of this, the candidate can either 
be given a standard performance-based test on one or both of these applications when he 
or she arrives in the office (to deter cheating and determine exact areas of product 
knowledge) or given advanced tests, with the assumption that his or her Internet-based 
test scores were accurate and that now he or she can be assessed in advanced skills for 
placement in more high pay, high-margin assignments.  In the traditional model, extra 
testing just prolongs the already too-long time in your offices.  Using this new Internet 
model, the testing a candidate does in the office can be used to pinpoint his or her highest 
level of skill for more accurate placement. 
 
Similarly, Candidate B’s Internet test scores probably show that giving him or her tests 
on Excel and PowerPoint would be a waste of the candidate’s time and yours.  However, 
it would also help your office determine that a test on Word basic skills (rather than a test 
that covers all skill levels) would help decide if the candidate could be placed on 
assignments where simple word processing was a requisite.  Again, in a fraction of the 
time previously used to assess all candidates with the same tests, more accurate 
information is generated by combining an Internet-based pre-screen at home with a 
highly-targeted performance-based test in the office.  
 
This type of system would need to be integrated with a staffing organization’s application 
and interviewing system.  However, the benefits of letting your testing systems build on 
one another include: 
 
• Far more efficient use of candidate time in your office, shrinking a visit from 1.5 – 2 

hours to easily under an hour. 
 
• More efficient use of that time to perform more targeted screening 
 
• Better use of interview time with more accurate test information at hand when an 

interview takes place 
 
• A better experience on the part of applicants who are being screened more efficiently 

and placed more accurately in jobs that reflect their proper skill level. 
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Because the objective of a home-based Internet test is to determine skill level, rather than 
determine knowledge of specific product features, tests can be designed to quickly and 
efficiently ascertain that level.  Tests that combine questions on multiple skills are one 
type of assessment that can be given at home.  Other strategies, such as adaptive testing 
(symbolized by products such as SkillCheck’s TimeSolver), can also be used to 
determine skill level with far fewer questions than are used in traditional in-office 
performance-based tests. 
 
The key to making such a system work is to think of Internet and office-based testing as 
an integrated whole.  While the tests perform different purposes, Internet-based tests and 
office-based tests should be designed to “fit together” so that information gathered from a 
home-based test can be used to make accurate decisions once the candidate reaches your 
office. 
 
 
Example 2 – Pre-Training Assessment 
 
As many staffing services have made a commitment to training via computer-based 
training (CBT) or other types of training solutions, pre-assessment to determine where a 
candidate does and does not need training is a perfect area to test at home.  Since job-
decisions do not hinge on the outcome of training pre-assessment, security is a non-issue.  
And pre-training assessment outside of the office requires no time commitment from your 
office and can significantly cut down training time spent in your offices.  If training itself 
is to be delivered over the Internet, an organization can create an efficient online training 
“university” with little to no time commitment required by your offices. 
 
 
Example 3 – Job Fairs and One Site Locations 
 
The ability to do large-scale screening at job fairs and other locations also requires an 
efficient system for screening numerous candidates quickly and accurately.  Again, a well 
designed test designed to ascertain skill level or knowledge on multiple skills can 
perform this function in a much shorter time than any other testing method.  And this data 
can be used to make subsequent testing, training and interviewing decisions. 
 
 
Conclusions 
 
Today, nearly all major staffing services have rejected one-size-fits-all testing with its 
me-too marketing message, in favor of testing that more reflects the standards of 
traditional testing bodies in certification and licensure.  All of the issues staffing 
companies are facing (performance-based vs. linear, centralized vs. distributed, flexibility 
vs. security concerns on the Internet) have parallels in the certification industry. 
 
Effectively moving testing to the Internet involves more than high-quality questions and 
answers (although these are the brick and mortar of any effective testing system).  
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Effective use of Internet technology requires a thinking through of critical goals 
including: 
 
• Increasing the efficiency and accuracy of the application procedure 
• Increasing the number of candidates that can be processed effectively with existing 

human resources 
• Better placement of job candidates 
• A marketing message that reflects a company as an effective user of the Internet, 

rather than a me-too provider of Internet-based linear testing 
• Building a system-wide framework that can continue to make effective use of the 

latest testing technology, understanding that this technology will certainly change 
with the speed of the Internet. 

 
As staffing services assess their complete testing picture, keep in mind that any 
successful testing program involves more than picking the best testing products.  It 
involves effective, coordinated, creative use of both technical and human resources to 
ensure that testing contributes to better and higher-volume recruitment, and more 
accurate and successful placement, the cornerstones of success in the staffing industry. 
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Appendix A 
 
Benefits of Performance-Based Testing 
 
The benefits of performance-based assessments are best illustrated by the following 
example: 
 
The two questions below each have the objective of assessing an examinee’s ability to set 
margins with the popular word processor, Microsoft Word for Windows: 
 
Which of the following commands will 
allow you to change margins? 
  
AA..  From the File menu, select Margins.  
  
B. From the File menu, select Page 

Setup 
 
C. From the Format menu, select 

Margins. 
 
D. From the Format menu, select 

Paragraph. 
 

 

 
This traditional linear test item (utilizing a multiple-
choice question format) is testing just one 
component of the objective being measured, notably 
which menu choice contains an option to change 
margins.  The question is not put into the context of 
the software program, and does not ask examinees 
to perform a complete software task. 

 
This performance-based testing item, in contrast, 
places examinees in a perfect simulation of the 
software environment and asks them to perform the 
task from start to finish in any correct way the 
software allows.  Only a fully-interactive 
performance-based item allows one to test all 
components of the objective in a single test item. 

 
It is generally understood that while traditional linear test items are best suited for 
assessing the understanding of concepts, performance-based testing is best for assessing 
skills, particularly skills in using computer software features and functions.  A perfect test 
is likely one that combines the most appropriate item types to test specific objectives. 
 
In addition to performance-based test items being most suitable for assessing certain 
objectives, general benefits of performance-based test items include: 
 
• Extremely high statistical item performance  
• High face validity and satisfaction from test takers 
• Item efficiency, whereby one performance-based test item can fill the roll of several 

linear test items on the same subject 
• A more clearly defined match between a test question and the job task 
• Performance-based test items present a task in its proper context 
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